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Use Of Equipment

Z Corporation's Equipment, and use of the Equipment, may be subject to limitations imposed under pat-
ents licensed to or owned by Z Corp., and is to be used solely for the fabrication of appearance models 
and prototypes using new Z Corporation-supplied consumables from Z Corporation or its authorized dis-
tributors in the original packaging. Other uses may be restricted; contact Z Corporation for further informa-
tion. Consult the User's Manual before operation of any Z Corporation Equipment. The Equipment may be 
covered by the following U.S. Patents and/or U.S. Patent Applications:

5,204,055 5,340,656 5,387,380 6,007,318 6,375,874 5,902,441
60/558,940     08/771,009     60/612,068    60/789,758   10/999,847   11/000100    
60/741,573   60/808,721   09/706,350     09/835,292    11/453,695    60/472,221   
10/848,831   6,416,850     6,610,429     6,403,002    6,989,115       7,037,382      
7,087,109     11/335,282    10/817,159   10/650,086

The Equipment is designed to be used by design engineers and other professionals in the production of 
early-stage 3D appearance models and prototypes. The Equipment is not to be used to produce, either 
directly or indirectly, medical or other products that may require precise dimensions or tolerances to ensure 
the safe and effective operation of such products. You agree to indemnify, defend and hold Z Corporation 
and its officers, directors and employees harmless from and against any and all claims, losses, damages, 
costs and expenses resulting from any use of the Equipment other than for the production of early-stage 
appearance models and prototypes.

Overview Of The ZPrinter® 450 Hardware Manual Chapters

1 - ZPrinter 450 Overview. Details the ZPrinter 450 specifications and computer requirements; pro-
vides a brief overview of the principles behind 3D printing; a process diagram; a list of important terms; 
labelled diagrams of the ZPrinter 450 components and the Control Panel; a description of the printer 
Accessories Kit; and where to go for more information.

2 - Setup And Print The Build. Describes the necessary steps for printing a part with step-by-step 
instructions; a description of the options available for transforming a part; how to create a part fixture 
and why you may need to use one; a description of the ZPrint™ Printer Status and Printing dialogs; 
automatic and manual powder removal options; and how to use the fine powder removal chamber.

3 - Routine Cleaning.  Guides you through simple routine cleaning the operator performs after every 
build including vacuuming up excess powder, cleaning the Service Station, cleaning the Parking Caps, 
and emptying the Debris Filter.

4 - Post-Processing.  An overview of post-processing and how to use Z-Bond™, Z-Max™, and infil-
tration systems for part strength and finish. Provides links to information regarding different infiltration 
systems, and ZShop, where you can order online the consumables you need.

5 - Additional Operations. Covers how to add powder to the printer feeder, raise the build bed plat-
form, add binder, and change a print head.

6 - Printer Maintenance.  Details the periodic maintenance required for keeping your printer running 
smoothly and problem-free. Includes steps for lubricating the Fast Axis bearing, the Slow Axis bearing, 
and the Piston Screw; changing the Binder Waste Tray; cleaning the Alignment Sensor Window; 
checking the Cleaning Fluid; and printer storage preparations.

7 - Troubleshooting. References the online Help Troubleshooting Guide for common errors.
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1 ZPrinter 450 Overview
Welcome to the exciting world of 3D Printing with our newest 3D Printer, the ZPrinter 450. The ZPrinter 
450 incorporates many new features that automate and streamline the 3D printing process. The full-color 
capability, an easy-to-use, quiet, office-friendly design, combined with high-performance composite materi-
als, makes ZPrinter 450 the fastest, most cost-effective 3D printer available today for rapid prototyping. 

This manual will instruct you on how to take care of your printer and give you an introduction to 3D Printing. 
In addition, you can find information about 3D printing and its many applications and techniques on our 
3DP User Group Website at www.3dpuser.com. This Website is tailored to both beginner and advanced 
customers. We recommend that you register immediately to receive free, unlimited access to this excellent 
resource.

1.1 New Features

• Automated Powder Loading/Removal/Recycling
• Quick-Load Binder Cartridge
• New, Single Print Head Color Technology
• Expanded On-Printer Controls
• Automatic Powder Removal
• Integrated Fine-Powder Removal Chamber
• Full-Color Capability

1.2 Specifications
 

Printer Dimensions and Type • With top cover closed: 48” wide x 31” deep x 55” 
high. (122cm wide x 79cm deep x 140cm high)

• With top cover open: 48” wide x 31” deep x 72.3” 
high. (122cm wide x 79cm deep x 183cm high)

• Floor standing model on four casters. The front two 
casters are lockable. 

• Full color capability; Color Shell Thickness =.025”.

• Integrated powder removal and vacuum units.

Printer Weight 425 lbs., 193 kgs.

Workstation Compatibility Windows® 2000 Professional; Windows XP® Profes-
sional; Windows Vista™ 32-bit.

Network Connectivity TCP/IP 100/10 Base T.
www.3dpuser.com 1 All Rights Reserved
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1.3 Recommended Computer/System Requirements
• Windows® 2000 Professional; Windows XP® Professional; and Windows Vista™ 32-bit Operating 

Systems 

Operating Environment

• Ambient Temperatures

• Ambient Relative Humidity

Maximum Temp. Range: 50-85° F (10 - 29.4° C).
Recommended Temp.Range: 55-80° F (12.7 - 26.6° C).

Maximum RH Range: 15 - 70%, non-condensing.
Recommended RH Range: 20 - 60%, non-condensing.

(May experience sub-optimal performance at extremes.)
Build Volume 8” x 10” x 8” (203 mm x 254 mm 203 mm).

640 cubic inches build capacity.

Build Speed 2-4 layers per minute.

Layer Thickness .0035” - .004” (.089 - .102 mm).

Color Shell Thickness .025”

Resolution 300 x 450 dpi print resolution.

Noise Levels During Printing = 57dB
Emptying Overflow = 66dB
Vacuuming - Cover Open = 86dB
Fine Powder Removal = 80dB

CSA, CE Approval Meets CE certification standards and UL standards. 

Power Requirements 100V, 14.4 Amp.

115V, 14.0 Amp.

230V, 6.2 Amp.

Note: Due to high amperage, a dedicated outlet is 
strongly recommended.

Materials - High Performance Com-
posite

zp130 Powder/zb59 Binder.

Dimensional Tolerances Parts printed with High Performance Composite materials 
can be reliably printed to be within +/- 1.0% or +/- 0.005” 
dimensional tolerance. 

Printheads HP11 (clear binder) and HP57 (single tricolor CMY print-
head).

Liquid Waste System None. Evaporative Waste System. 
www.3dpuser.com 2 All Rights Reserved
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• 3.2GHz processor or better (recommended)
• 2GB RAM or better (strongly recommended)
• True Color Graphics
• 64 MB Video Card, or better
• 1024 X 768 pixels, or better
• 16-bit or better with graphics card accelerated for OpenGL
• 1GB free space
• Ethernet 100/10 Base T

These system configurations may require a higher performance computer based on file size and type. 
For more information, please contact your local Reseller, or visit our Website at www.3dpuser.com. 

1.4 How 3D Printing Works

The 3D Printing System is based on the Massachusetts Institute of Technology's patented 3DP™ Technol-
ogy (3D Printing). The 3D Printing process requires:

• A 3D Printer 
• Importing a solid 3D modeling file into the ZPrint Software 
• Setting up your files to print in the ZPrint/ZEdit Software
• Printing, powder removal, and drying the part
• (Optional) Applying post-processing materials to the printed part

To start, the ZPrint Software takes a three-dimensional design file, (ZPrint is compatible with most 3D mod-
eling software files) and converts it into cross-sections, or layers, that are between 0.0035" - 0.004" (0.089 
- 0.102 mm) thick. Before printing, ZPrint evaluates the part geometry and checks if there are enough 
materials in the printer to print the number of layers required to build the part. If there are, the printer then 
prints each layer, one after the other, from the bottom of the part to the top. If not, ZPrint will prompt you to 
add powder, to add binder, or to change a print head before it will start the print job. 

During printing, binder is first applied with a higher saturation to the edges of the part, creating a strong 
"shell" for the part exterior. Next, an infrastructure that works like strong scaffolding is created for the part 
walls, which are also built with a higher saturation of binder for added strength. The remaining interior 
areas are printed with a lower binder saturation, which gives the part its stability.

When the part is finished printing, the printer heats up to the appropriate temperature and dries the part 
while it is still in the Build Bed surrounded by powder. When the drying cycle is finished, an automatic pow-
www.3dpuser.com 3 All Rights Reserved
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der removal cycle empties the Build Bed of most of the excess powder around the part, and returns that 
powder to the Feeder for reuse. After the bulk of the powder removed, the part is moved from the Build 
Bed to the integrated Fine-Powder Removal Chamber where any remaining powder is cleaned off the part.  

After the part is powder-free, it is ready to be removed from the printer. You can evaluate the part as it is, or 
you can choose to post-process the part with infiltration products to give it additional strength, durability, 
and color vibrancy. With the finished part in your hands, you can start improving or modifying your design 
within the same day, and usually within hours.

1.5 3D Printing Process Diagram

1.6 Important Terms

Air Wand - The tool located in the Fine-Powder Removal Chamber that supplies air pressure. Use this tool 
to remove all remaining powder from a part after the initial (automatic or manual) powder removal.

Alignment Sensor Window - Located on the underside of the Carriage unit. Wipe powder off of the Align-
ment Sensor Window every time you replace a print head, or whenever you remove a print head to clean 
the contacts.

Binder - Solution that is dispensed through the HP11 print head and applied to the powder. The binder sat-
uration value will vary depending on the part geometry. The ZPrint software uses a default core and shell 
saturation value that is suitable for most part geometries. 

Build Bed - The 8” x 10” x 8” area in front of the Feeder where the part is printed. The platform of the Build 
Bed can be raised or lowered using the appropriate command on the printer LCD menu. Before each build, 
the printer fills the Build Bed with powder and then spreads a layer of powder to ensure the surface of the 
Build Bed is completely smooth.

Build Chamber - The left, interior side of the printer that houses the Build Bed, Service Station, Parking 
Caps, the Debris Filter, the Carriage, the Gantry assembly, the Vacuum Hose, the Heater Vent, and the 
Feeder. 

Carriage - Assembly that houses the Print Heads, Pogo Pin Connectors, and the Alignment Sensor Win-
dow.

Consumables - Powder-Binder-Infiltrant products that are available in a variety of systems for all of your 
color or monochrome modeling needs. All consumables have been developed for the fastest printing 
speeds and lowest materials costs.
www.3dpuser.com 4 All Rights Reserved
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Debris Filter - Located above the Heater Vent in the Build Chamber. Its function is to prevent chunks of 
particles from going back into the printer Feeder during any vacuuming operation. 

Deck - Area surrounding the Build Bed.

Depowder - Process of removing excess powder from a newly printed part. First, there is the initial (auto-
matic or manual) powder removal process, which removes the bulk of the powder after the part is dried in 
the Build Bed. After the initial powder removal, there is the fine-powder removal process - which cleans the 
part of all remaining powder. 

Feeder - Printer component that stores powder. Powder that is vacuumed up after a build, or powder that 
is automatically (or manually) emptied from the Build Bed, is recycled and returned to the Feeder for reuse. 

Fine-Powder Removal Chamber - The right, interior side of the printer that houses the Glovebox and the 
Air Wand. Printed parts are moved from the Build Bed to the Fine-Powder Removal Chamber for final 
removal of any powder left on the part.

Gantry - Printer component that houses the Carriage and the Fast Axis rails that the Carriage moves on. 
The Gantry moves on the Slow Axis rails which are housed beneath the Build Chamber Deck.

Glovebox - Storage space located inside the Fine-Powder Removal Chamber. Use the Glovebox to store 
your printer accessories and manuals.

Heater Vent - Located directly below the Debris Filter. The Heater Vent supplies heat to the Build Chamber 
during the warm-up cycle, and during the drying cycle.

Infiltration - Process of applying various post-processing products (resins, wax, epoxy, etc.) to fully 
depowdered parts to give them specific properties such as strength, durability, and color vibrancy.

LCD - Liquid Crystal Display.

Parking Caps - Printer component that prevents the print heads from drying out between print jobs. It is 
important to clean the Parking Caps after every build.

Platform - The bottom, metal plate of the Build Bed. The platform contains numerous small holes that 
allow excess powder to escape through the bottom of the Build Bed during initial (automatic or manual) 
powder removal. The platform can be raised or lowered by selecting the appropriate command on the 
printer LCD menu.

Pogo Pins - Gold contact pins for the print head contacts. Clean the Pogo Pins with an alcohol swab 
whenever a print head is removed, cleaned, or replaced. 

Powder - Very fine particles that are not bound together. Powder is spread layer by layer and saturated 
with binder to create a solid object.

Powder Screen - Located behind the Debris Filter, the round powder screen prevents any large pieces of 
debris from entering the Feeder.

Print Head - There are two for the ZPrinter 450. One (HP57) for color inks (CMY), and one (HP11) for 
clear binder. When a new HP11 print head is installed, the printer runs an automatic purge cycle to clean 
the print head of its ink and to prepare it for dispensing binder.

Print Head Contacts - The contact points on a print head cartridge that match up with the Pogo Pins. 
www.3dpuser.com 5 All Rights Reserved
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Purge - Process of removing ink from the HP11 print head to prepare it for dispensing binder.

Service Station - Cleans the print head jets to remove powder residue during printing. It is extremely 
important to clean the Service Station after every build to remove residue buildup that gets left on the Ser-
vice Station during a build. If the Service Station is not clean, your print heads will not get properly cleaned 
and this will result in premature print head expiration.

Waste Tray - Absorbs the binder waste and will require changing only when you are prompted to in ZPrint. 
Located at the rear, bottom of the printer. You must remove the printer back, bottom Cover Panel to change 
the Waste Tray. 

1.7 ZPrinter 450 Components

   

ZPrinter 450 Front View  ZPrinter 450 Front View With Top Cover Open
www.3dpuser.com 6 All Rights Reserved
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1.8 ZPrinter 450 Rear View Diagram

 

ZPrinter 450 Rear View
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1.9 Electronics Box Ethernet Connector

1.10 Service Station

1.11 Parking Caps
www.3dpuser.com 8 All Rights Reserved
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1.12 Carriage, Print Heads, and Pogo Pins

    

Carriage Open With Print Heads With Print Heads Removed

1.13 LCD Menu And Control Knob (LCD Panel)

LCD Menu and Control Knob
Control Knob Operations:

Push the Control Knob once to:
• Bring up the LCD menu.
• Select a menu item.
• Open a submenu.
• Start/Cancel/Stop a menu function.

Turn the Control Knob left or right to:
• Highlight a menu item. 
• Increase or decrease the air pressure to the Air Wand during Fine-Powder Removal.

1.14 LCD Menu Overview

Main Menu

Vacuum
Depowder
Prep Build Chamber 
Status Report
Printheads > 
Build Chamber >
Go Online

Printheads Submenu

Main Menu >
Change Printheads
Align Printheads
Purge HP11 Printhead

Build Chamber Submenu

Main Menu >
Raise Platform
Lower Platform
Spread Layer
Fill Bed
Empty Build Chamber
www.3dpuser.com 9 All Rights Reserved
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1.15 Accessories Kit

1.16 Where To Go For More Information

A Quick Start Guide is shipped with your printer Accessories Kit and will quickly get you printing parts. It 
has pictures and simple, step-by-step instructions to guide you through a print job. If you need an addi-
tional copy of the Quick Start Guide, please visit our Website at www.3dpuser.com to view or print a pdf 
version.

Manuals for the ZPrint and ZEdit Software programs are available on our Website at www.3dpuser.com in 
pdf versions. Both programs include a searchable Help system and links to additional information on our 
User Group Website regarding 3D applications and printing/post-processing techniques.

Learn more about the different post-processing products that are available to use with your printer, on our 
User Group Website at www.3dpuser.com.

Top Level:

1 - Cleaning Fluid
2 - ZPrint/ZEdit CD
3 - Screwdriver
4 - Debris Filter
5 - Ethernet Cable
6 - Cable

Not Pictured: 3/16” Hex Key

Middle Level:

1 - Syringe
2 - Grease Gun
3 - Tubing for Syringe
4 - Pick
5 - Grease Gun Nozzle
6 - Grease Cartridge
7 - Water Bottle

Bottom Level:

1 - Soft Bristle Brush
2 - Stiff Bristle Brush
3 - Vacuum Attachment
4 - Vacuum Attachment
5 - Medium Bristle Brush
6 - Vacuum Attachment

Your kit also includes a Welcome Letter, Quick Start 
Guide, and trays for transporting parts.
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To order consumables/materials, visit ZShop at www.3dpuser.com. If you are an international customer, 
you can order consumables directly from your local service provider or reseller.
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2 Setup And Print The Build
2.1 Overview To Printing Speed, Part Strength, And Part Accuracy

There are three important characteristics to 3D printing that will help you print the best parts for your 
intended purposes. Keeping these concepts in mind, you have the basis for becoming an expert 3D printer 
operator. 

• Part Placement = Printing Speed. The ZPrint Software automatically positions parts in the Build 
Bed for maximum build speed by placing parts with the smallest dimension in the Z-Axis. 

• Strength. The ultimate strength of an uninfiltrated part will be somewhat affected by its orientation 
within the Build Bed. The part will be strongest along the X-Axis and Y-Axis and less strong along 
the Z-Axis. This is because the cross sections are printed in continuous strips along the Y or the 
"fast" axis (the print heads’ direction of travel); in bands across the X or the "slow" axis (the gantry 
direction of travel); and in laminated layers along the Z-Axis. Once a part is infiltrated, it uniformly 
takes on the strength characteristics of the infiltrating product.

• Accuracy. The accuracy of your part depends on how clean the printer is, your printer/powder set-
tings, and the materials you choose for post-processing. You can also employ features like Aniso-
tropic Scaling to adjust for expected shrinkage and bring your parts into true scale. More 
information on Anisotropic Scaling can be found in the ZPrint™ Software Manual.

2.2 Overview To Part Orientation

Parts that lie in the X-Y plane will be stronger than those aligned on the Z-Axis. If a part has a particularly 
delicate feature, especially one shaped like a thin rod, align that feature in the X-Y plane for the greatest 
strength. If a part has particularly delicate features that are supported only by unprinted powder, build a 
Fixture for the part to reduce the chances of breaking the feature during powder removal. See Section 2.9 
for instructions on how to create a Fixture.
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Do not tightly pack multiple parts into the Build Bed. If multiple parts are tightly packed, it may be difficult to 
lift them out of the Build Bed with proper support. If a delicate part is being built with other more solid parts, 
add a Fixture to the delicate part to protect it during powder removal.

2.2.1 Parts Containing an Opening or Hollow Area

Place the hollow side of a part facing down in the Build Bed to allow powder to evacuate during powder 
removal. Depending on how the part is imported into ZPrint, you may need to use the Rotate feature to 
correctly orient the part. Build parts that are delicate with a Fixture, to give them extra support and addi-
tional protection during powder removal. See Section 2.9 for instructions on how to create a Fixture.

An example of a part with hollow sides facing down

2.2.2 Parts Containing Overhangs

For delicate parts and parts with overhangs, create a Fixture, or create a Fixture for the area of the part 
that needs support. Unsupported overhangs are placed on the rear-most side of the Build Bed, as close to 
the bottom of the Build Bed as possible. See Section 2.9 for instructions on how to create a Fixture. 

An example of a part with two Fixtures to support the overhangs
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2.2.3 Parts Containing Cylindrical Features

Cylindrical features will be more accurate when the cylindrical axis is parallel to the Z-Axis.

The remainder of this chapter takes you through setting up your build in ZPrint and printing a part.

2.3  ZPrint/ZEdit Installation

If ZPrint has not been installed, you will first need to install it. Installation instructions are available in the 
ZPrint™ Software Manual. Be sure to install the software on the same computer that is connected to your 
3D Printer.

If you encounter any problems during installation, please contact your local Service Provider or Reseller, or 
visit our Website at www.3dpuser.com.

2.3.1 ZEdit

ZEditTM is an add-on software that ships with ZPrint. ZEdit was developed by a team of software develop-
ers and application engineers as a tool to help those who use HD3DP™ (high-definition 3D printing) to 
optimize their color applications. This software program works in conjunction with the ZPrint software. Use  
ZEdit to apply color or labels to your part, as well as to diagnose and correct simple file problems. Color 
may be applied to a part through the application of a texture map, engineering template, text, or by using 
the paint features.

Customers should install ZEdit when ZPrint is installed. See the ZPrint™ Software Manual for installation 
instructions. Refer to the ZEdit™ Software Manual, or the ZEdit Online Help, for specifics about using this 
software.

2.4 Open A Part In ZPrint

1. Launch the ZPrint Software. The Splash screen will close on its own after a few seconds, or you 
can click the OK button to immediately close the screen.

2. In the Open dialog, select a file to print, or browse to a file on your computer. Click the Open but-
ton, or double click on a file to open it in ZPrint.
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3. If the Choose Units dialog opens, choose the display units that correspond to the part dimen-
sions and then click Next. The file is opened in a new ZPrint window using the units specified in 
this dialog.

4. If you would like to add additional files to the build, select File > Import and select more files. By 
default, ZPrint will position each file in the Build Bed for the fastest print time. 

• If you do not want ZPrint to position your part(s) for printing speed, uncheck the Orient 
imported parts for the fastest times option on the Settings > General Preferences > 
Import/Export tab. 

2.5 ZPrint Main Window

See the ZPrint™ Software Manual for a complete description of the Main Window. 
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2.6 Check Or Change The Default Printer Settings

1. Select Settings > Printer Settings to display the Default Printer Settings dialog.

2. In the Default Printer Settings dialog, check that the default printer is the printer that is connected 
to your computer. 

• If it is not, click Select Printer and proceed with Step 3.

• If it is, click Cancel and skip the rest of this procedure.

3. In the Select 3D Printer dialog, choose Network as the Port Type. Click the Find button to locate 
the printer on the network. If the printer is connected to the network, it will appear on the list. Select 
the printer and click OK. 

4. The Default Printer Settings dialog reopens showing your new default settings. To save your set-
tings, click the Save As Default button. You can change these settings at any time by repeating 
Steps 1 - 4.
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2.7 Check The Default Powder Settings

1. Select Settings > Powder Settings to display the Powder Settings dialog.

2. Select the printer and the powder type from the left-side panel to view the settings for that combi-
nation. 

• ZPrint defaults to the recommended powder settings for the Layer Thickness, Saturation 
Levels, Binder/Volume Ratio, Bleed Compensation, Anisotropic Scaling and Fixture 
Clearance.

Important: Most of the powder settings cannot be changed, but you can override the settings for 
the Layer Thickness, Bleed Compensation, Anisotropic Scaling, and the Fixture Clearance 
for the current build only. We do not recommend changing these, but should you need to:
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• Select File > 3D Print Setup to disable the Bleed Compensation, or to change the Layer 
Thickness. 

• Select Transform > Anisotropic Scaling to change the values for Anisotropic Scaling. 

• Select Edit > Make Fixture to change the Fixture Clearance amount. This value is the small-
est amount of space between the Fixture and the part, without actually touching.

2.7.1 Create A New Powder Type

You can create a new powder type and enter new data in the fields that are activated in the Powder Set-
tings dialog. The new settings must be saved under a unique powder name and will be added to the left-
side panel after saving. See the ZPrint™ Software Manual for complete instructions on how to create a 
new powder type.

2.8 Transform The Part in ZPrint

The ZPrint Transform menu has several options for transforming parts. Following is a brief overview to 
help familiarize you with some of these options. For a complete description of the Transform menu, please 
refer to the ZPrint™ Software Manual.

ZPrint Transform Menu

  Translate Toolbar Shortcut

Positions the selected part by the amount specified 
for the X, Y, and Z coordinates. The default values of 
0,0,0, represent the lower-left corner of the Build 
Bed.
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  Rotate Toolbar Shortcut

Rotate/Rotate Group - Rotates the selected part in 
the specified plane (view).

Select your part (left-click on the part in ZPrint) and 
select Transform > Rotate. Select the plane (view) 
to rotate the part in and then enter the degree of 
rotation in the degrees field. 

Enter a negative value to rotate the part clockwise 
by that amount.

  Scale Toolbar Shortcut

Scale/Scale Group - Scales the selected part by 
the dimensions specified in the Relative or the X, Y, 
and Z fields. 

Select the part. Select Transform > Scale. Limit the 
scale to the maximum limits of the build area - 8 x 10 
x 8 inches. 
(203 mm x 254 mm 203mm).

  Mirror Toolbar Shortcut

Mirror/Mirror Group - Mirror a part in the X, Y, or Z 
direction.

Select your part. Select Transform > Mirror.  
Choose a direction to mirror the part.

  Justify Toolbar Shortcut

Justify/Justify Group - Aligns or "justifies" the 
selected part to a specified location in the Build Bed. 
Options include Left/Right, Front/Back, and Bot-
tom of the Build Bed. 

Select the part. Select Transform > Justify. 
Choose your settings.

If a part extends outside of the Build Bed, ZPrint 
prompts you with a warning message and outlines 
the part with a red wire frame. You can manually 
adjust the position of the part with your mouse, or 
you can use the Justify dialog.
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2.9 Fixtures

A Fixture is a grid-shaped object with a top surface between the bottom-most surface of the part, (without 
actually touching the part), and the bottom of the Build Bed. Generate a Fixture under a part, or a portion of 
a part, to create a "cradle" that is easily handled during transport, depowdering and post-processing. An 
optional bumper feature is available to provide additional protection during automatic powder removal for 
especially delicate parts, or multiple parts in the same build. 

NOTE: ZPrint will evaluate the geometry of the part and build the smallest Fixture necessary, with 
minimum use of materials.

Generate a Fixture for an entire part, for a portion of a part, or for a part feature that needs additional sup-
port. Fixtures also provide these benefits:

• Supports parts during powder removal process.

• Supports delicate, thin parts for easy removal from the printer and handling during post-process-
ing.

• Keeps multiple parts from bumping into each other, or into the Build Bed walls during powder 
removal.

• Increases accuracy in the Z-Axis for parts with large overhangs. 

• Helps prevent "squash" effects for hollow cylindrical parts, or parts with overhangs. 

NOTE: Squash effect results from an overhang being supported with only unprinted powder. For 
example, if a part is a hollow round cylinder, such as a scope, the weight of the powder above the 
cylinder will cause it to "squash" to something less than round, if there is no support underneath.

2.9.1 Create a Fixture for an entire part:

1. Select the part in ZPrint.

Undo - Select to undo your last transformation 
action. 

• Undo works for the last action taken. You 
cannot undo multiple actions. 

• Undo only applies to the commands on the 
Transform menu.
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2. Select Edit > Make Fixture. ZPrint orients the part in the 3D View for building the Fixture.

NOTE: The settings in the Make Fixture dialog are the General Preference settings that are pre-
set in the software and the recommended settings for the printer. See the ZPrint™ Software Man-
ual for a description of the Make Fixture dialog should you need to change any of these settings. 

3. There are two features you may choose to enable for a Fixture:

• Make Bumper: To add a bumper to a fixture, check the Make Bumper checkbox. A bumper 
will be generated on the Fixture base.

• Holes between walls: Powder may get trapped between the Fixture and the part. You can 
generate a Fixture with holes at the grid intersections to allow powder to escape during auto-
matic powder removal. A zero (0) in this field means no holes are generated on the Fixture. 
The higher the percentage, the larger the holes will be on the Fixture. 

4. Click OK. The Fixture is generated.

     

5. Select View > Collision Detection to ensure the Fixture is not touching the part. If the Fixture is 
touching the part, do the following:
• Select the fixture and press Delete on your keyboard.
• Open the Make Fixture dialog and increase the Accuracy Coefficient value by 1 (one).
• Click OK to regenerate the Fixture.
• Run Collision Detection again.

2.9.2 Create a Fixture for a portion of a part:

1. Select the part in ZPrint. ZPrint orients the part in the 3D View for building the Fixture.

2. Select Edit > Make Fixture.

3. In the 3D View, point the mouse on the wire frame in the top, left corner, press Shift and the left 
mouse button. Drag the box to an area of the part that you want to support.
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• To Resize: Point on the box, press the left mouse button and drag the mouse to resize the 
box.

• To Rotate: Point on the box, press Ctrl and the left mouse button. Drag the mouse to rotate 
the box.

4. When you have positioned the box, click OK in the Make Fixture dialog. The Fixture is generated 
for the specified area.

2.10 Check the Build Layers for Errors or a Collision

It is strongly recommended that the Slice View (2D icon) and Collision Detection be utilized before 
beginning a build. 

• The slice view is toggled on the ZPrint 3D View menu when you select the Switch Layer View / 
3D View command, or by selecting the 2D icon on the Toolbar. When printing single or multiple 
parts, slice viewing allows you to view the cross sections of the part(s) to identify any errors in the 
file. 

• Collision Detection is located on the ZPrint View menu. When printing multiple parts, or a part 
with a Fixture, always run Collision Detection to scan through the slices and see where layers of 
a part may be overlapping or touching another part, or the Fixture. 
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2.11 Check The Build Settings 

Before printing, always check your build settings.

1. Select File > 3D Print Setup, or click  on the Toolbar. 

2. Check that the printer listed in the Select Printer field is the printer connected with the computer 
running ZPrint, and that the printer is Online. 

• If the printer is Offline, the Select Printer field will display Offline beside the printer name. 
Click the Select Printer button to locate an Online printer via a Network connection.

3. Bleed Compensation is checked (On) by default. For most ZPrinter 450 users, the Bleed Com-
pensation setting should not be unchecked (Off) except in a couple of special situations: 

• If you are building a part for visualization purposes only, uncheck Bleed Compensation so 
the part will build with slightly thicker dimensions for added strength. 

• If your part is a complex assembly containing many shells and you can see lines between the 
shells, or if the part tends to break at the shell boundaries, uncheck Bleed Compensation to 
weld together the places in the assembly that are slightly touching. Leaving Bleed Compen-
sation checked will tend to create fracture lines between abutted sections.

4. Click OK.

2.12 Prepare the Build Area

Go to your printer and check each item listed below to ensure the printer is ready to print. It is important to 
check each of these items before every build. 

• Check that the Deck, Gantry, and Build Bed are clean of any powder. See Section 3.1 for 
instructions on how to vacuum up excess powder from these areas.

• Check that the Debris Filter is empty. See Section 3.2 for instructions on how to empty the 
Debris Filter.
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• Check that Parking Caps are clean. See Section 3.3 for instructions on how to clean the Park-
ing Caps.

• Check that Service Station is clean. See Section 3.4 for instructions on how to clean the Ser-
vice Station.

• Check that the platform is raised to the top of the Build Bed. Select Prep Build Chamber > 
Continue on the LCD menu to raise the platform to its proper position.

A clean, properly prepared Build Bed

2.13 Print the Build

1. Select File > 3D Print, or click  on the Toolbar, to display the Printer Status dialog.

NOTE: ZPrint checks the printer readiness and calculates the materials needed to complete the 
build. The results are reported in the Printer Status dialog for you to check before starting the 
build. 

• The dialog shows OK for each item and the Print button is enabled when the printer is ready. 

• If you see a message and the Print button is not available for selection, see Chapter 5 - Addi-
tional Operations for instructions on how to clear a message.
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2. Choose your options for the build in the Print Job Options section of the Printer Status dialog.

• Print in Monochrome - Prints a color part in monochrome (no color). Printing in monochrome 
speeds up the print time and is useful for prototypes that do not require color for evaluation.

• Preheat Build - Delays starting the print job until the printer has reached its full temperature.

• Delay Start Time - Opens a dialog where you enter a specific time to start a print job.

• Empty Build Piston After Printing - Checked by default. When checked, the printer will auto-
matically remove the bulk of the powder from the Build Bed after the part has printed and 
dried. (Automatic Powder Removal)

Important: If you want to utilize the automatic powder removal feature and you are printing a 
delicate part, build a Fixture for the part. 

3. Check the Printer Status window to see what is currently displayed on the printer LCD menu. The 
printer must be Online before you can start the print job. 

4. When all of the items in the Print Heads, Powder, and General sections show OK, the Print but-
ton is enabled. Click Print to start the build. Before starting the build, the printer will: 

• service the print heads
• fill the Build Bed with powder and then spread one layer to make the top surface smooth

NOTE: The printer allows you to start a build if a Head Alignment will be performed, or if the 
Build Temperature is warming up. 

5. The Printing dialog opens and tracks the following information for the duration of the build:

• Estimated Finish Time
• Estimated Time Remaining
• Layer % Completion status bar
• Starting Time
• Elapsed Time
• Pause Button - Click to pause the build. Click again to resume the build
• Cancel Button - Click to cancel the build
• Cross-section view (2D) of the current build
• Part orientation of the current build as it is printing, in the X-Z Axis (side view)
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2.14 Dry The Part

When your part is finished printing, the printer runs a drying cycle. A timer on the LCD menu will count-
down the time remaining to dry the part. Drying the part gives it added strength, so you should not handle 
parts before they have adequately dried. 

• You can leave the part in the Build Bed after the drying cycle ends and it will continue to 
increase in strength. The longer a part is dried the stronger it becomes, although until it is infil-
trated, it will still be fragile and should be handled with care. 

2.15 Automatic Powder Removal

Your part prints and dries in the Build Bed surrounded by unused powder. There are three ways to 
remove unused powder from the Build Bed after the drying cycle is finished:

• Unused powder is automatically removed from the Build Bed when the Empty Build Piston 
After Printing option is checked in the Printer Status dialog.

• If you unchecked the Empty Build Piston After Printing option but would still like to utilize 
this feature, you may do so at the printer. Select Build Chamber > Empty Build Chamber on 
the LCD menu to start the Automatic Powder Removal cycle.

• If you unchecked the Empty Build Piston After Printing option, you can manually excavate 
the part by vacuuming powder away using the vacuum hose. Check the part orientation in 
ZPrint before you begin vacuuming.

Important: For delicate parts, or parts with especially delicate features, it is recommended that you 
build the part with a Fixture when using the Automatic Powder Removal feature. 

If a part is too delicate to handle the low-level vibration during the Automatic Powder Removal cycle, 
uncheck the Empty Build Piston After Printing option and manually excavate the part using the 
vacuum hose.
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NOTE: Unused powder that is emptied or vacuumed from the Build Bed is recycled back into the 
printer Feeder so it can be used for future builds. 

2.16 Fine Powder Removal

After the bulk of the powder is removed from the Build Bed, gently pick up the part and place it in the Fine-
Powder Removal Chamber where you clean the part of any remaining powder with the Air Wand. 

1. Open the printer top cover. 

2. Select Build Chamber > Raise Platform on the LCD menu. Hold the Control Knob down to raise 
the platform closer to the top of the Build Bed. 

3. Gently lift the part and place it in the Fine-Powder Removal Chamber.

4. Close the printer top cover and select Depowder on the LCD menu to start the air compressor.

5. Slide your arms into the chamber through the two openings and remove the Air Wand from its clip. 

• Test the air pressure against your hand before applying air to the part. Adjust the pressure by 
turning the printer Control Knob left to decrease the pressure, or right to increase the pressure.

• Use light pressure for delicate or thin-walled parts. If the air pressure is too strong, you run the 
risk of breaking a feature.

6. Apply air to the part to clean off all remaining powder. 

Best Practices For Vibrant Colors: Brushing your part before infiltration will greatly enhance its 
color. Go over the part using the 2" Soft Bristle Brush, the double-ended Stiff Bristle Brush, or the 
Medium Bristle Brush that is shipped with your printer Accessories Kit. Not every part will look like 
it needs brushing, but every part will benefit from brushing and will assure the best possible fin-
ished part. After brushing the part, use the Air Wand to remove any remaining powder on the part.

     

Refer to the Color Quality Best Practices document for complete information.

Best Practices For Cleaning: When finished, use the Air Wand to quickly clean the Fine-Powder 
Removal Chamber of all powder. Apply air around each side of the chamber and the backside of 
the top cover to remove any excess powder.

7. Turn the air compressor off by pushing the Control Knob once and return the Air Wand to its clip. 
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8. Open the printer top cover and move the part to your post-processing station, or leave it in the 
chamber to continue drying and strengthening. 

2.17 The Next Step

Best Practices in 3D Printing requires cleaning the printer after each build. Doing this will keep your printer 
in optimal running condition and greatly minimize errors that can result from powder build up, particularly 
on the print heads and the moving parts of the printer. A good time to do these few, simple tasks is after the 
fine powder removal session (while the part continues to dry), and before post-processing. 

Cleaning and preparing the printer for the next build takes only a couple of minutes and will greatly reduce 
the chance of hardware errors and printer down time. A clean printer also means your print heads will last 
longer, and parts will print precisely and have more strength before infiltration. See Chapter 3 - Routine 
Cleaning for complete details on how to perform these simple routine tasks. After you have cleaned and 
prepared the printer for the next build, proceed with Chapter 4 - Post-Processing.
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3 Routine Cleaning
This chapter describes the routine cleaning the printer operator performs after every build to prepare the 
printer for the next build and to keep the printer running smoothly and problem free. These four tasks take 
only a few minutes to perform but go a long ways in preventive maintenance by minimizing residue buildup 
on the print heads and the printer components. 

3.1 Vacuum Excess Powder

After every build, vacuum loose powder in the Build Chamber, including the Build Bed, Deck, and Gantry. 
To vacuum:

1. Select Vacuum on the LCD panel. 

2. Open the printer top cover and remove the vacuum hose from its stand.

3. Vacuum any excess powder in the Build Bed, around the Deck, and on top of the Gantry. Pull the 
Gantry forward and check for powder towards the back of the Build Chamber as well.

• You can leave powder in the Feeder (the area behind the Build Bed where powder is spread to 
the Build Bed), but the powder remaining in the Build Bed after a print job should be vacu-
umed.

• The vacuum will stop automatically after a couple of minutes, or you can push the Control 
Knob once to shut off the vacuum. 

     

Build Bed Deck

     

Top of Gantry Top of Gantry

4. When you are finished, return the hose to its stand.
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3.2 Empty The Debris Filter

After vacuuming, empty the Debris Filter. The Debris Filter catches any large particles and keeps those 
pieces from entering the vacuum overflow system. To empty the Debris Filter:

1. Pull the Debris Filter out of its holder on the printer.

2. Empty the contents into a trash receptacle.

3. Return the empty Debris Filter to its holder. Be sure to push the filter flush against the holder for a 
secure fit.

     

3.3 Clean The Parking Caps

The Parking Caps provide a clean, surface for seating the print heads between builds.

Before you begin:
• Get several dry paper towels
• Get the squirt bottle included in your Accessories Kit
• Fill the squirt bottle with distilled water

1. Lift the Parking Cap cover to a horizontal position and place a dry paper towel underneath.

2. Squirt the distilled water onto the cover to clean the Parking Caps. Do not squirt water into the 
powder. 

3. Use a dry paper towel to wipe the Parking Caps clean.

4. Remove the paper towel and wipe up any excess water on the Deck.
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3.4 Clean The Service Station

The function of the Service Station is to clean the print heads during printing. Clean the Service Station 
after every build to remove residue buildup and to ensure the printer runs optimally for your next print job.

Before you begin:
• Get several dry paper towels and place them around the Service Station
• Get the squirt bottle filled with distilled water
• Get a cotton swab
• Get the Pick from the Accessories Kit

1. Open the printer top cover and then open the Service Station cover.

2. Pull down on the Service Station wiper lever and hold it down to properly position the squeegees 
for cleaning.

3. Position the squirt bottle close to the unit and squirt water on and around the squeegees and down 
into the Service Station. 

4. Take the cotton swab and wipe the front and back of the squeegees to remove any powder resi-
due. Use the Pick to scrape off any excess powder that collects in the area in front of the squee-
gees. 

     

Use the Pick tool to clean any residue that collects in the area above the squeegees

5. Let the water drain through the drain hole at the bottom of the unit. 
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6. Wipe up any excess water and thoroughly wipe the Service Station clean. 

7. Push the wiper lever back to its original position.

8. Wipe up any water that may have spilled onto the Deck.

9. Close the Service Station cover and then close the printer top cover.
www.3dpuser.com 32 All Rights Reserved

10/2/07

https://www.3dpuser.com


ZPrinter® 450 Hardware Manual Post-Processing
4 Post-Processing
All printed parts can be post-processed with a variety of infiltration products to produce a wide range of 
material properties. If you are building an early stage design prototype, it may not be necessary to post-
process the piece at all. However, the true versatility of 3D printing is derived from the variety of properties 
that are achieved by applying an infiltration product to parts that will be used in a product-testing environ-
ment. For additional information on how customers are utilizing our line of post-processing products, visit 
our Website at www.3dpusers.com.

4.1 Using Z-Bond™ CyanoAcrylate 

Z-Bond CyanoAcrylate is an extremely fast-setting, ultra-low viscosity, general purpose infiltration product. 
It is designed to rapidly strengthen parts. It is a user-friendly, no-odor, non-blooming resin, that is easily 
sanded and painted. Not only do you get strong parts, but Z-Bond enhances the vibrancy of models printed 
with color. For additional information, please see the Z-Bond ™ User Guide at www.3dpuser.com.

Safety Precautions

• Do not use or handle this product until the Material Safety Data Sheet has been read and under-
stood.

• Wear a lab coat or smock, gloves, face shield, or goggles. A face shield is required if you are 
spraying this product. 

• Apply in a well-ventilated area.

• Specialized containers are recommended for applying Z-Bond. Have a catch pan, waxed paper, or 
plastic drop cloth available for catching spills.

• Label disposal materials and dispose of according to the label instructions.

• Wear a dust mask when sanding finished parts.

• Z-Bond reacts with water and ambient moisture. Once a bottle has been opened, it is recom-
mended that the product be used within 30 days. Avoid all contact with water and avoid use under 
high humidity conditions. If Z-Bond is exposed to excessive humidity, it will thicken up and become 
improper for infiltration.

• Store Z-Bond in a cool, dry area.

INFILTRANTS MATERIAL SYSTEM APPLICATION

Wax High Composite Material Dip 
Z-Bond™ CyanoAcrylate High Composite Material Dip or Drizzle

Z-Max™ Epoxy High Composite Material Spray or Brush
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General Application Notes

• Part should be fully dried before applying Z-Bond. Z-Bond reacts with water and produces heat. If 
the part is not dried, it will heat up and produce gas that may be an irritant to the mucous mem-
branes.

• Material can be dipped or drizzled.

• Material will penetrate the part shell up to 0.12” (3 mm).

• Do not over-apply the material, as it may pool on the part during the curing cycle, which may cause 
the part texture to change. Wipe excess liquid off of the part with paper towels.

Curing Information

• The part should be placed on a non-stick material (wax paper, Teflon®, etc.) to prevent it from 
adhering to the surface it is sitting on while curing.

• Do not handle parts during curing. Let the part dry at least 30 minutes before handling.

• Parts will attain full strength in two minutes.

Tips

• When dipping parts, ensure the container is large enough to fully submerge the part in the Z-Bond.

• Fully submerge the part for ~10 seconds. If you see air bubbles, wait until the bubbles stop before 
removing the part.

• When dipping or drizzling Z-Bond onto a part, be sure to constantly move the part in your hands to 
keep it from sticking to your gloves. 

• The best combination for protecting your hands and avoiding getting your fingers stuck to the part 
is to wear a vinyl or nitrile glove as a first layer and a PE, food-service type glove over it.

4.2 Using Z-Max™ Epoxy

Z-Max Epoxy is a high-strength epoxy infiltration system specifically formulated for Z Corporation. Z-Max is 
a low-viscosity, high strength, infiltration system designed to strengthen parts built on any Z Corporation 
printer. Z Corporation parts infiltrated with Z-Max are easily sanded and surface machinable. For additional 
information, please see the Z-Max™User Guide available at www.3dpuser.com.

Safety Instructions

• Read the Material Safety Data Sheet for Z-Max prior to the use of this material.

• Wear a lab coat or smock, gloves, face shield or goggles. A face shield is required if spraying. 

• Apply in a ventilated hood.

• Specialized containers are recommended for dispensing and applying Z-Max. Have a catch pan, 
waxed paper, or plastic drop cloth available for catching spills.
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• Label disposal materials and dispose of according to the label instructions.

• Wear a dust mask, gloves, and protective clothing when sanding finished parts. Fully cure the part 
before sanding to avoid generating dust that may contain uncured epoxy.

Mixing Instructions

• Mix according to the package instructions.

General Application Notes

• Z-Max can be brushed or sprayed.

• Z-Max will penetrate the part shell between 0.079 - 0.28 inches (2 - 7 mm).

• If Z-Max is over-applied, it will pool off the part during curing.

• Better penetration depth is achieved by applying several light coats of Z-Max.

• Allow all mixed materials to cure prior to disposal. 

Spraying Instructions

• Have the sprayer, parts and materials ready before mixing Z-Max.

• Mix Z-Max and pour into the disposable liner of the spray canister.

• Always spray in a vented hood. Use of a respirator is also recommended.

• Spray Z-Max between 15 - 20 psi (pounds per square inch)

• When finished, remove the disposable liner and clean sprayer with ethyl alcohol or acetone. 

• Remove the sprayer tip and thoroughly clean by hand to avoid residue build up.

Curing Information 

• Allow the part to cure for 1 hour at ambient temperature to avoid discoloration prior to placing in an 
oven for accelerated curing.

• Z-Max will cure at an accelerated rate in an oven. The oven must be vented. Ventilation designs 
need to meet each customer’s respective governmental health and safety requirements. A refer-
ence frequently used by U.S. firms to comply with OSHA regulations is the American Conference 
of Governmental Industrial Hygienists Industrial Ventilation Manual. 

• At 160° F (71° C) your part will reach full strength in 2 hours. Z-Max will also completely cure at 
room temperature after 24 hours.

• The part should be placed on a non-stick, material (wax paper, Teflon®, etc.) to prevent it from 
adhering to the surface it is sitting on while curing.

• Always wear gloves when handling the parts that are still curing at elevated temperatures. Parts 
will attain full strength and be safe to handle once they cool to room temperature. 
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Tips

• If the part has delicate features, infiltrate them last as the feature will be less strong after being 
infiltrated until the epoxy begins to cure. This will decrease the chance the feature will break from 
the part if nudged or bumped.

• If the part has multiple delicate features, or it is impossible to handle the part without breaking a 
feature, infiltrate these features first. Allow the Z-Max to cure and then infiltrate the rest of the part. 
This will add time to post-processing the part but it ensures that you have a good strong part with-
out any fractures.

• To avoid wasting Z-Max when infiltrating a large part, mix several small batches, instead of one 
single, very large batch, or split your large batch into several containers. 

4.3 Using Paraplast X-TRA Wax 

Paraplast X-TRA Wax is a low-viscosity, general purpose, wax product formulated to melt at very low tem-
peratures (122° F or 50° C) and strengthen parts. This product cures rapidly and enhances the vibrancy of 
color parts. It is economical, easy to handle, and simple to store. Please see the Paraplast® X-TRA Wax 
User Guide at www.3dpuser.com for additional information.

Safety Precautions

• Liquid wax is hot and will cause burns if spilled onto skin. Follow all manufacturer recommended 
safety precautions for your dip tank prior to use.

• Wear gloves when handling hot parts.

General Application Notes

• Parts should be dried in an oven at 100° F (38° C) prior to infiltrating with wax for deeper wax pen-
etration.

• If the part is bulky, you may preheat it at 150° F (66° C) for up to 30 minutes.

• Soak part in liquid wax tank (follow all tank manufacturer's instructions).

• Remove infiltrated part from dip tank.

• Place part in an oven at 150° F (66° C) until the wax has penetrated or melted off your part (usu-
ally around 15 minutes).

• Be aware that these are simple guidelines. Your specific applications may require additional steps. 

Curing Information

• Allow your parts to cool after removal from the oven until the part is no longer warm to the touch.
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5 Additional Operations
When you start a print job, ZPrint checks the printer to ensure there are enough materials to complete 
the job and that the printer is properly prepared before starting the job. If the printer does not have 
enough powder, binder, or print head life to complete the job, a message appears in the Printer Status 
dialog telling you what you need to do to prepare the printer before printing. 

Important: Do not add powder or binder to the printer, or change a print head, unless you see a mes-
sage telling you to in the Printer Status dialog. 

In the example above, the Printer Status dialog on the left is ready for printing. Notice that each item 
shows OK, (except for the Build Temperature), and the Print button is enabled. From here you would 
choose your printing options and click Print to start the job. Before the printer starts printing your file, it 
will first: 
• fill the Build Bed with powder
• spread a layer to ensure the Build Bed surface is smooth
• service the print heads
• run an auto-alignment if a print head was replaced or removed for cleaning after the previous build

If there are not enough materials to complete the job, or the printer is not properly prepared, a mes-
sage appears similar to the example on the right above. When any one of these messages appears, 
the Print button is disabled. The remainder of this chapter describes how to clear a message in the 
Printer Status dialog and start the build. 

ZPrint allows you to continue and print if:
• The printer build temperature is still warming up.
• A Head Alignment will be performed. The Head Alignment runs before the part begins to print. 
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5.1 Change Print Head(s)

ZPrint checks the status of the print heads before every build. If a print head needs to be changed, 
ZPrint displays CHANGE PRINT HEAD in the Printer Status dialog. You will not be able to start the 
build unless you have changed the appropriate printhead. 

• Do not change the print heads unless prompted to in the Printer Status dialog. 

• When the HP11 (black) print head is changed, the printer runs an automatic purge cycle to 
clear the print head of its ink and prepare it for binder. 

• When either print head is replaced, or removed from its slot for cleaning, the printer will run the 
Auto-Alignment pattern to properly align the print heads before the next build is started.

1. Select Print Head > Change Print Head on the printer LCD menu. The gantry moves to the ser-
vice position.

        
2. Open the printer top cover and then open the carriage cover.

3. Lift both print head out of their slots and properly dispose of any empty cartridge(s).

4. Open an alcohol swab (included with your Startup Kit), and squeeze the tube to saturate the swab.

5. Wipe off all the pogo pins (inside the carriage) for both print heads with the alcohol swab.

6. Wet a paper towel with distilled water and wipe off the underneath of the carriage. When finished, 
press Continue on the LCD. 
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Important: Clean the underneath of the carriage every time you change a printhead, and no less 
than every 3-6 weeks depending on your machine usage. 

   Residue buildup on the underside of the carriage could result in printhead errors (such as 40006, 
or 2303:1). Refer to the Troubleshooting Guide chapter for information on how to access the 
ZPrinter® 450 Troubleshooting Guide. 

7. Remove all new cartridge packaging. Be sure to pull the tape tab off of the new cartridge.

8. Re-insert each cartridge. Press down firmly on the side of the pogo pins to securely fit a cartridge 
into its slot. 

9. Close the carriage cover by pressing down until you hear the cover click shut.
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10. Close the printer top cover and then press Continue > Exit on the LCD.

• The gantry reparks and the printer goes Online. The printer will run an auto-alignment pattern  
before starting the next print job to properly align the print heads.

5.2 Add Or Change Binder

ZPrint evaluates the geometry of a part and determines if there is enough binder to complete the job. If not, 
ZPrint displays ADD BINDER in the Printer Status dialog. You cannot start the build until you add binder 
to the printer. If the printer reservoir is empty, it will take two (2) Binder Cartridges to fill the reservoir. 

If you need to change the binder, you can by simply inserting a new Binder Cartridge. There is no need to 
run out the current binder and the reservoir does not need to be empty before adding a different binder. For 
example, to change from zb59 to zb60, insert the zb60 cartridge in place of the zb59 cartridge and con-
tinue printing as usual. 

To add or change Binder:

1. Pull the empty binder cartridge out of its housing on the printer and dispose of the cartridge 
according to the label instructions.

2. Get a new binder cartridge and check the cartridge label for the correct orientation.

3. Insert the new cartridge into its housing. Ensure the cartridge is pushed all the way in. You should 
feel it gently snap into place.

• If the cartridge does not snap into place, do not force it. Check the orientation on the label and 
try again.
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5.3 Add Powder To The Feeder

ZPrint evaluates the geometry of the part to determine if there is enough powder in the Feeder to com-
plete the build. If not, ZPrint displays ADD POWDER in the Printer Status dialog. You cannot start the 
build until you add powder to the Feeder. Do not add powder unless all of the powder in the Build Bed, 
Overflow (front and rear), and Deck has already been returned to the Feeder, via a vacuuming opera-
tion.

1. Place a powder bucket in the Fine-Powder Removal chamber and remove the round cap from the 
bucket cover. 

2. Plug the vacuum hose into the fitting on top of the bucket. 

3. Select Vacuum on the LCD menu. The vacuum will automatically shut off when the Feeder is full, 
or the bucket is empty. The LCD displays Feeder Full when the Feeder is filled to capacity.

4. Return the vacuum hose to its stand, replace the round cap if there is powder left in the bucket, 
and remove the bucket.

5.4 Build Piston (Build Bed)

The Build Bed platform must be in its proper position at the top of the Build Bed in order for the printer 
to fill the bed and spread a layer of powder before starting a print job. If you see the message RAISE 
BUILD in the Printer Status dialog, go to the printer and select Prep Build Chamber to raise the plat-
form to its proper position.

5.5 Cover

The printer cannot start a print job when the top cover is open. If the top cover is open, go to the printer 
and close it. Do not open the cover while the machine is printing.
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6 Printer Maintenance
This chapter details how to perform occasional maintenance on your printer and how to prepare your 
printer for storage if you will not be running it for 4 months or longer. Most of these procedures are only 
performed when you are prompted to in the ZPrint Maintenance dialog. Others should be performed at the 
recommended frequency detailed with each procedure below.

• Fast Axis Bearing Lubrication
• Slow Axis Bearing Lubrication
• Piston Screw Lubrication
• Change The Waste Tray
• Check The Wash Fluid Level
• Clean The Alignment Sensor Window
• Clean the Fast Axis Bumpers
• Bleed Air
• Printer Storage Preparation

The Maintenance dialog (found on the ZPrint Service menu) keeps a record of when the Fast Axis bear-
ing, the Slow Axis bearing, and the Piston Screw require lubrication. ZPrint will prompt you when lubrica-
tion of any of these components is required. Only lubricate these components when you are prompted to in 
ZPrint.

While lubrication of these items is important, it is equally important not to over-grease the bearings and pis-
ton screw when lubricating. Only a very small amount of grease is required to keep these parts working 
optimally. Over-greasing creates a situation where grease builds up in places where it should not be, and 
may cause the printer to throw an error. 

6.1 Fast Axis Bearing Lubrication

Frequency: When prompted in ZPrint.

1. Open the printer top cover and pull the gantry forward until it stops.
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2. Take a couple of paper towels and wipe down the two rails behind the gantry metal cover. 

3. Assemble the grease gun that ships with your Accessories Kit according to the instructions. Before 
attaching the grease nozzle, prime the grease gun into a paper towel until grease comes out.

4. Place the tip of the grease gun over the bearing located on top of the Gantry. 

     

5. Squeeze the trigger until you see grease begin to come out of the relief hole (located just to the 
front of the pulley belt) and STOP. Do not over-grease. 

6. Manually move the carriage back and forth several times across the rails to evenly distribute the 
grease. Wipe away any excess grease you see coming out of the relief hole, on the bumpers, and 
on the rails with a paper towel.

Best Practices: 

• Take a cotton swab and clean off any residue on the two bumpers located at either end of the 
rails. 

• Clean the teeth of the pulley assemblies located at both ends of the pulley belt with the Pick 
Tool that is included in your Accessories Kit.

7. Reset the Maintenance Counter in ZPrint.
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6.2 Slow Axis Bearing Lubrication

Frequency: When prompted in ZPrint.

1. Locate the round plastic cover on the Deck to the left of the Build Bed and close to the Service Sta-
tion.

2. Take a flat head screwdriver or a Pick Tool and pop the cover off to expose the bearing through the 
opening. Be careful not to scratch the deck surface. An alternative method is to reach your fingers 
under the left side of the deck and pop the cover off.

3. Pull the Gantry forward until you see the Slow Axis bearing in the center of the opening.

4. Assemble the grease gun that is part of your Accessories Kit according to the instructions.

5. Place the tip of the grease gun over the bearing.
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6. Squeeze the trigger until you feel the tension change and then STOP. Do not over-grease.

7. Replace the plastic cover.

8. Reset the Maintenance Counter in ZPrint.

6.3 Piston Screw Lubrication

Frequency: When prompted to in ZPrint.

1. Remove the back, bottom cover panel of the printer. 

2. Lower the Build Bed platform as far as you can (Build Chamber > Lower Platform) to expose the 
entire length of the piston screw. Remember to hold the Control Knob down to lower the platform. 

3. Assemble the grease gun that is part of your Accessories Kit.

4. From behind the printer, squeeze the trigger twice at the top of the Piston Screw (under the Build 
Bed), and then squeeze the trigger once at the middle of the Piston Screw.

5. Spread the grease up and down the Piston Screw to evenly distribute it over the entire length of 
the screw.
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6. Raise the Build Bed up and down a couple of times (Build Chamber > Raise Platform and Build 
Chamber > Lower Platform) to finish lubricating the screw. (Don’t forget to hold down the Control 
Knob to raise or lower the platform.)

7. Wipe off any grease that may collect at the bottom of the screw with a paper towel.

8. Replace the back, bottom cover panel.

9. Reset the Maintenance Counter in ZPrint.

6.4 Change The Waste Tray

Frequency: When prompted to in ZPrint. Your Dealer or Service Provider will change the Waste Tray as 
part of your annual maintenance contract. If you do not have a Service Contract, or you are prompted 
before the annual maintenance, follow these instructions.

1. Remove the back, bottom cover panel of the printer.

2. Pull the Waste Tray out of its holder.

3. Remove the Waste Tray and dispose of according to the packaging instructions.

4. Replace with a new Waste Tray.

5. Slide the Tray back into place. Push the Tray in until it goes no further.

6. Replace the back, bottom cover panel.

7. Reset the Maintenance Counter in ZPrint.
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6.5 Check the Wash Fluid Level

Frequency: When prompted to in ZPrint. Keep in mind that the cleaning fluid is very long-lasting and a lit-
tle fluid lasts a long time.

1. Open the top cover and then open the Service Station cover.

2. Remove the red cap and check the wash fluid level. The tank should be half full.

• If the tank is less than half full, add wash fluid (zc10). Do not fill to the top. You need to leave 
room to reinsert the red cap.

     

3. Reinsert the red cap and close the Service Station cover.

4. Reset the Maintenance Counter in ZPrint.

6.6 Clean The Alignment Sensor Window

Frequency: Clean the Alignment Sensor Window every time you change a print head, or remove a print 
head to clean the contacts and pogo pins.

1. Take a paper towel and squirt a little distilled water on it.

2. Open the top cover and pull the gantry forward until it is positioned over the front overflow vent.

3. Slide the carriage over to the right side of the gantry.

4. Reach under the carriage unit and thoroughly wipe the Alignment Sensor Window with the paper 
towel. 
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6.7 Clean the Fast Axis Bumpers

The Fast Axis measures the distance between these two bumpers when re-zeroing. If the distance is too 
long, or short, a 2400 (1) error will occur. The bumpers may be perceived by the printer as missing (due to 
grease buildup) or damaged.

The photos below show the location of each Fast Axis bumper. If you are facing the printer, the left Fast 
Axis bumper is above the top rail as in the picture on the right below. The right-hand Fast Axis bumper is 
below the top rail as in the picture on the left below.

 This is the right-side bumper.                            This is the left-side bumper.

If you get a 2400 (1) error, visually check the bumpers for residue buildup. Take a paper towel and thor-
oughly clean off any residue on both bumpers. 

6.8 Bleed Air

IMPORTANT NOTE: The only time you need to bleed air from the binder lines is if you get a 1006 (0) Error 
at the printer, or in ZPrint. Contact your Service representative before you bleed air from the binder lines.

1. Open the small cover on top of the carriage and visually locate the Printheads. 
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2. Remove the Binder Printhead (HP11) and locate the septum, which is the small, round device with a 
white rubber seal.

3. Find the syringe and piece of tubing that is part of the Accessories Kit. One end of the tubing screws in 
to the tip of the syringe, and the other has a fitting that is designed to push into the septum.

4. Insert the black fitting over the septum and push down so that the needle in the fitting penetrates the 
rubber membrane of the septum. 
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5. Extract two full syringes of binder (to remove any air in the line) and empty the binder into a waste 
receptacle. Use a paper towel to catch any binder that may drip out of the tubing when you remove the 
fitting from the septum to empty the syringe.

 
6. Extract one last full syringe of binder and slowly squeeze ¾ of the binder back through the line. This 

will assure that no air bubbles remain in the binder line. Dispose of any remaining binder in the syringe.

7. Clean the pogo pins and Printhead contacts with an alcohol swab and reinsert the Printhead. 

8. Close the carriage cover. The Auto Alignment will run before your next print job to realign the Print-
heads.

6.9 Printer Storage Preparation 

It is recommended that you leave your ZPrinter 450 turned on during idle times so it can routinely service 
the print heads and exercise the moving components. However, if you choose to leave the printer turned 
off for more than 4 months, before using the machine again, you will need to pull a syringe of binder 
through the lines (to remove any air), and replace the printheads because they will be dried out.

Contact your local Service Provider, or an authorized Z Corporation representative, to discuss any con-
cerns before storing your printer.
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7 Troubleshooting

Please refer to the Online Help for a complete Troubleshooting Guide by error code for the ZPrinter® 450. 
If you still cannot find a resolution to an issue or error, contact our Service Department, or your local Service 
Provider/Reseller. Service contact information is listed below and on our 3DP User Group Website at 
www.3dpuser.com.

By following the instructions for routinely cleaning your printer, most customers will never need to trouble-
shoot their printer. Most errors can be avoided by practicing diligent routine cleaning on your printer. Keep-
ing your printer clean will maximize the life of the print heads and will ensure that you are able to build the 
most accurate and strongest parts possible.

To access the ZPrinter® 450 Troubleshooting Guide:

In ZPrint, open the Help Menu and select Troubleshooting Guide.

Click on an error code link on the page that loads, or open the Troubleshooting book (on the Help TOC lo-
cated on the left-hand navigation pane) and make a selection.
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You can also use the Help Search tab to search on a specific error.

7.1 Service Contact

Service Online Information
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